
Upcoming Meetings

Here is a list of mini’app’les meetings for the next two months. The information was compiled as this news-
letter was being assembled and is subject to change. As always, confirm the Special Interest Group (SIG) date, 
time, and location with the cognizant SIG Leader or the mini’app’les web site (http://www.miniapples.org).

September Calendar

* This SIG is NOT sponsored by 
mini'app'les; the listing is provided as a 
service to members.

October Calendar

* This SIG is NOT sponsored by 
mini'app'les; the listing is provided as a 
service to members.

The mini’app’les Newsletter is an independent publication not affiliated, sponsored, or sanctioned by Apple, Inc. or any other 
computer manufacturer. The opinions, statements, positions, and views are those of the author(s) or newsletter staff and are not 
intended to represent the opinions, statements, positions, or views of Apple, Inc. or any other computer manufacturer. Instead of 
placing a trademark symbol at every occurrence of a trade-marked name, we state we are using the names only in an editorial manner,  
to the benefit of the trademark owner, with no intention of infringement of the trademark.
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Tuesday September 02 7:00 pm  Mac OS X SIG
Wednesday September 03 6:30 pm  iWork/AppleWorks SIG
Wednesday September 10 7:00 pm  Microsoft Word SIG
Wednesday September 10 7:00 pm  VectorWorks SIG*
Thursday September 18 7:00 am  Macintosh Consultants SIG
Monday September 22 7:00 pm  Mac Q&A SIG
Thursday September 25 7:00 pm  FileMaker Pro SIG

 MEETING  LOCATION  LEADER
 Board of Directors  Merriam Park Library, 1831 Marshall Ave, St Paul  Bruce Thompson, 763-546-1088
 FileMaker Pro SIG  Partners, 2250 Terminal Rd, Roseville  Steve Wilmes, 651-458-1513
 iWork/AppleWorks
 SIG

 Penn Lake Library, 8800 Penn Ave S, Bloomington  John Hunkins Sr, 651-457-8949

 Mac OS X SIG  The Foundation, 311 7th Ave N, Minneapolis  Bob Demeules, 763-559-1124
 Mac Q&A SIG  Merriam Park Library, 1831 Marshall Ave, St Paul  Les Anderson, 651-735-3953
 Macintosh
 Consultants SIG

 Good Day Café, 5410 Wayzata Blvd, Golden Valley  Bob Demeules, 763-559-1124

 Microsoft Word SIG  Edina Executive Plaza, 5200 Willson Rd, Edina  Tom Ostertag, 651-488-9979
 Multi-SIG Meeting  St. Charles School, 2727 Stinson Blvd, Minneapolis  Tom Gates, 612-789-1713
 TC Photoshop SIG*  Minneapolis College of Art & Design, Auditorium

 150, 2501 Stevens Ave S, Minneapolis
 Jeff Tranberry, phone number not
 available

 VectorWorks SIG*  CJR Office, 4441 Claremore Dr, Edina  Charles Radloff, 952-941-1667

Wednesday October 01 6:30 pm  iWork/AppleWorks SIG
Tuesday October 07 7:00 pm  Mac OS X SIG

Wednesday October 08 7:00 pm  TC Photoshop SIG*
Wednesday October 08 7:00 pm  Microsoft Word SIG
Wednesday October 08 7:00 pm  VectorWorks SIG*
Thursday October 16 7:00 am  Macintosh Consultants SIG
Monday October 20 7:00 pm  Board of Directors Meeting
Thursday October 23 7:00 pm  FileMaker Pro SIG
Saturday October 25 9:00 am  Multi-SIG Meeting
Monday October 27 7:00 pm  Mac Q&A SIG



Board of Directors
President Bruce Thompson
 763-546-1088
 bthompson@macconnect.com

Vice President David Peck
 612-423-5711
 beornsthunder@gmail.com

Secretary Harry Lienke
 651-457-6026
 plienke@aol.com

Treasurer Don Walz
 651-426-5602

Membership Director Chuck Hauge
 612-963-5064
 Chaz@CPHSolutions.com

Publications Director HELP NEEDED
 Please let a Board member
 know if you are interested

SIG Director Kevin Strysik
 65l-489-4691
 strysik@mac.com

Director at Large Tom Gates
 612-789-1713
 tgates@isd.net

Membership  Erik Knopp
Coordinator

CHANGE OF ADDRESS
Moving? Going to be away from home and leaving a 
forwarding address with the Post Office? Changing to 
a better email provider? Please send us a Change of 
Address when you are informing others. By using a 
moment of your time, you ensure you receive a 
notice when your club membership is expiring and 
you get your newsletter email notification delivered 
promptly. Change of Address should be sent to the 
club's mailing address (mini’app’les, Attn: 
Membership Director, Box 796, Hopkins MN 55343) 
or to the club’s email address 
(miniapples@mac.com).

Introduction — This is the newsletter of mini’app’les, the 
Minnesota Apple Computer Users’ Group Inc., a Minnesota 
non-profit club. The whole newsletter is copyrighted© by 
mini’app’les. Articles may be reproduced in other non-profit 
User Groups' publications except where specifically 
copyrighted by the author (permission to reproduce these 
articles must be given by the author). Please include the source 
when reprinting.

Questions — Members with technical questions should refer 
to the Members Helping Members section or bring their 
questions to an appropriate SIG meeting. Please direct other 
questions to an appropriate board member. 

Dealers — mini’app’les does not endorse specific dealers. The 
club promotes distribution of information that may help 
members identify best buys and service. The club itself does not 
participate in bulk purchases of media, software, hardware, and 
publications. Members may organize such activities on behalf 
of other members.

Newsletter Contributions — Please send contributions 
directly to our post office box (mini’app’les, PO Box 796, 
Hopkins MN 55343) or email them to miniapples@mac.com.

Deadline for material for the next newsletter is the fifteenth of 
the month. An article will be printed when space permits and, if 
in the opinion of the Newsletter Editor or Publications Director, 
it constitutes material suitable for publication.

Newsletter Staff this month: Harry and Pam Lienke

The layout of this newsletter was done using Apple’s Pages 
word processor.

mini’app’les forums: http://miniapples.7.forumer.com
mini’app’les web site: http://www.miniapples.org
mini’app’les email: miniapples@mac.com
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From the Editor’s Desk — September, 2008

Volunteers Needed

Publications Director

Main Mac Special Interest Group Leader

iLife Special Interest Group Leader

Please contact a member of the Board of Directors to 
make known your interest in helping the mini’app’les.

SIG Reports

If you don’t see a report from your favorite Special 
Interest Group (SIG) in this issue of the newsletter, 
please speak to the SIG Leader and encourage him or 
her to provide a write-up for the next newsletter.

Thanks for your help.

Harry Lienke

mini’app’les Newsletter for September 2008 Page 3 of 16



Members Helping Members
Need Help? Have a question the manual doesn’t answer? Members Helping Members is a group of volunteers 
who have generously agreed to help. They are just a phone call or an email away. Please call only during the 
appropriate times, and only if you are a current mini’app’les member and own the software in question.

.....Apple II / IIGS Software & Hardware 1, 2
......................AppleWorks / ClarisWorks 3, 4

Classic Macs
....................Cross-Platform File Transfer 2, 3

FileMaker Pro
Intel Based Macs
iMacs

.......................................................iPhoto 3
iTunes / iMovie

........................................Mac OS Classic 3
Mac OS X

........................................Microsoft Excel 2, 5, 8
........................................Microsoft Word 2, 8

......................................................MYOB 5
..................................................Networks 7
................................................New Users 1

PhotoShop
............................................QuarkXPress 8

....................................................Quicken 5
...........QuickBooks and QuickBooks Pro 5

.............................................VectorWorks 6

1. Les Anderson 651-735-3953 anderslc@usfamily.net  DEW
2. Tom Ostertag 651-488-9979 tostertag@usfamily.net EW
3. Bruce Thompson 763-546-1088 bthompson@Macconnect.com EW
4. Pam Lienke 651-457-6026 plienke@aol.com DEW
5. Ardie Predweshny 612-978-9774  DEW
6. Charles Radloff 952-941-1667  D
7. Chuck Hauge 612-963-5064 Chaz@CPHSolutions.com D
8. Ron Heck 651-774-9151  DEW

D: Days, generally 9 am to 5 pm
E: Evenings, generally 5 pm to 9 pm
W: Weekends, generally 1 pm to 9 pm

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of these 
volunteers can also be contacted on our forums. We appreciate your cooperation.

mini’app’les needs more volunteers for Members Helping Members — If you are willing to be a 
Members Helping Member volunteer, please send an email message to Membership Director Chuck Hauge or 
contact him on our forums with your name, telephone number, contact hours, and the software or hardware 
areas you are willing to support.
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Multi-SIG Meeting

Join other mini’app’les members on Saturday, 
October 25, for a Multi-SIG meeting. Members will 
be available to help with hardware problems, software 
problems, and any questions you may have. High-
speed internet access will be available for those large 
system updates you have been putting off. Diagnostic 
software and tools will also be available. Bring the 
equipment that is giving you problems for help in 
resolving those problems. A ramp and two-wheeled 
carts will be available to help transport equipment 
between vehicles and the meeting room.

Several of our Special Interest Groups (SIGs) will be 
having sessions at this meeting.

If you have suggestions for a speaker or presentation, 
your Board of Directors would like to hear from you.

The time is October 25, 2008, from 9:00 am to 1:00 
pm. The place is St. Charles School located at 2727 
Stinson Boulevard NE.

How to Get to St. Charles School

To get to St. Charles School from I-35W, take the 
Stinson Boulevard exit and follow Stinson Boulevard 
north to the school at 27th Avenue.

From I-694 you should take the Silver Lake Road exit 
south to 37th Ave (County Road D) and turn right. Go 
west to Stinson Boulevard and turn left. Go south ten 
blocks on Stinson Boulevard to the school at 27th 
Avenue.
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Benefits of mini’app’les Membership

Access to the mini’app’les online forums. Post 
questions and/or answers about issues, trouble 
shooting, products, buying and selling, special events, 
discounts, and news about Apple and the mini’app’les 
club.

Access to our Members Helping Members network of 
professional and advanced users of Apple 
technologies. These members volunteer their time to 
help other members with software, hardware, and 
other Apple related issues.

A variety of Mac Special Interest Groups (SIGs) that 
meet each month.

Workshops to help members with computer problems. 
You can bring your equipment to these events and 
receive support from knowledgeable Mac users to 
help diagnose your problem(s).

Participation in drawings for computer hardware, 
software, and other computer related materials.

Discounts from vendors and manufacturers.

Comments on “Strong Passwords” Article

The following comments on August’s Strong 
Passwords article were posted on forumer.com on 
July 29.

andre writes:

Kudos to the new newsletter people! The content 
is useful and timely, the layout is easy to read. 
And the electronic format is handy and saves 
money and paper! Thank you so much! 

I would add to the strong passwords article: there 
is a way to make the Password Assistant create 
useful passwords that are very strong. There are 5 
or so settings in a drop down menu, one of which 
is "memorable". To create a strong password, 
crank the length up above 20 and you've got 
yourself an industrial-strength password that is 
easy to remember but very, very hard to brute-
force crack. The only drawback is that they take 
longer to type. I'd highly recommend using these 
types of passwords. With the increase in 
computing power, distributed computing, and 
storage capacity, it behooves everyone to use a 
password. Length beats randomness, too!

gregbuchner replies:

I agree André, but, unfortunately, there are too 
many sites that limit your password to 8 to 12 
characters. What I did for a password, one that I 
use far too often, was to type a bunch of random 
stuff by mashing the keyboard, pick out a 12 
character string out of that, and memorize it. But 
if a site lets you type in a long phrase, that's a 
much better option I think.
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iWork/AppleWorks SIG of August, 2008
by Harry Lienke

At a previous iWork/AppleWorks SIG meeting, 
someone asked if there was an easy way to pick a new 
font; the Font Menu on the Format Bar lists all fonts 
alphabetically so a change from Arial to Times 
requires one to scroll through virtually the entire Font 
list. Our genial facilitator, Pam Lienke, showed us 

how to use the Font Window to facilitate a font 
change. After selecting the text to change, she 
activated the Font Window from the far right side of 
the Toolbar (see Figure 1). The Font Window allows 
you to select from several font collections, including 
Favorites and Recently Used. It has a What-You-See-
Is-What-You-Get (WYSIWYG) feature accessed by 
clicking and dragging on the little circle located just 
under “Font” at the top, center of the window (see 
Figure 2). When Pam clicked on a font in the window, 
the selected text changed to that font. When she liked 

the way the text looked, she simply closed the Font 
Window and continued with her word processing.

One of the meeting attendees reported having 
difficulties incorporating an animated GIF (graphic 
interchange format) into Keynote. He reported that 
animated GIFs moved in Tiger Safari but not in 

Leopard Mail; he also indicated those GIFs were 
animated in Leopard Gmail. It appeared that browsers 
like Safari recognize animated GIFs but Mail does 
not. After downloading an animated GIF to our 
display machine, we began to experiment with it in 
Pages. At first we were only able to get the GIF to 
animate a single time when we double-clicked on it. 
After some investigation, someone discovered the 
QuickTime button on the Inspector. When the GIF 
was selected, the QuickTime controls became active; 
by setting the Repeat to Loop we got the GIF to 
animate continuously. The middle control at the 
bottom of the QuickTime window was used to start 
and stop the animation.

Pam demonstrated how a Shape selected from the 
Pages Toolbar can be used to mask a graphic so that 
only part of the graphic is visible. First she inserted a 
graphic into document and used the Format menu to 
Mask with Shape. Then she showed how the graphic 
and mask can be adjusted and how a frame can be put 
around the visible portion of the graphic.

Someone asked if a graphic can be used to create a 
tiled background. The pictures on our display 
machine had too high a resolution and were too big to 
tile, so, once again, an appropriate graphic was 
downloaded. From the Shapes menu on the Toolbar, 
Pam selected a rectangle that she expanded to fill the 
entire page. From the Graphic Inspector, she selected 
Image Fill from the Fill pull-down menu; clicking on 
the Choose button permitted her to select a graphic 
which appeared within the Shape. To create the tiled 
effect, she changed the second Fill pull-down menu to 
Tile; the rectangular Shape was magically filled with 
many copies of the graphic. The Opacity control at 
the bottom of the Graphic Inspector was used to 
lighten the background so the text in front of it was 
legible.

Someone asked if it is possible to animate a GIF and 
to tile a background in Mail. Bob Demeules ventured 
a guess that it could be done but we did not pursue 
this matter.

The next meeting is scheduled for Wednesday, 
September 3 at 6:30 pm at the Penn Lake Library 
(note the change in location!). Hope to see you there!
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Lesa's Graphic Secrets for MUGs

How to Resize Images from Digital Cameras

May 20, 2008

I bought my husband a Nikon D50 for Christmas a 
few years back and needless to say, he's totally 
obsessed with it. He's snapping pictures constantly 
and has outfitted it a couple of new lenses, a speed 
flash, and several multi-gig memory cards. He's all 
set, that is, until he transfers the images onto his Mac.

He doesn't know squat about resizing an image for 
print or an email. He's heard of resolution but doesn't 
have a clue what it means or when it matters. Bless 
his heart :)

Therefore, today I'm going to show you how to resize 
images with ease using Photoshop Elements. It's an 
amazingly powerful piece of software that's under 
$80 (click here to read the Macworld review). I'll start 
by covering basic graphic terminology and exploring 
the relationship between resolution and pixels. Read 
on!

What is resolution?

Image resolution is the number of pixels displayed 
per unit of printed length in an image. It’s a 
measurement used for printing (hence the phrase “of 
printed length”) and it’s usually stated in pixels per 
inch (ppi—used when referencing stuff onscreen) or 
dots per inch (dpi—used when referencing something 
that’s about to be printed because printers print dots).

What’s a pixel

The smallest picture element of any digital image is 
called a pixel. Images are displayed in tiny blocks 
(also referred to as dots) of color that together form 
an entire image. If you zoom into an image around 
300% or so, you'll start to see them. TIP: In Elements, 
just press Command + several times to zoom in, then 
Command - to zoom back out.

How do resolution and pixels work together?

The way resolution affects an image is thus: For a 
given number of pixels in the width or height of an 
image, any image can be measured at any resolution. 
The higher the resolution, the closer the printer packs 
those pixels together in order to make a beautifully 
smooth and sharp print. The closer the pixels are 
packed together, the smaller the image will be 
physically when it's printed. Conversely, the lower the 
resolution, the more loosely those pixels are packed 
and the larger the image can be physically--though it 
will print terribly. It'll look pixelated and chunky and 
people will giggle behind your back. Seriously :)

It's like brown sugar... really

Think of all this as the pixels in an image were 
granules of brown sugar (stay with me, it'll make 
sense in a minute). If you pour brown sugar into a 
measuring cup without packing it down, it might take 
up about a cup in space. If you were to pack it down 
with your fist, the same number of granules now takes 
up a 1/2 cup of space. The same amount of granules 
are in both a cup and 1/2 cup, it's just the density 
that's changed thereby changing how much physical 
space the granules comprise. Loosely packed granules 
are the equivalent of low resolution, while densely 
packed granules are the equivalent of high resolution.

Because our monitors can only display a certain 
amount of information that our eyeballs/brains can 
process, resolution changes cannot be seen onscreen. 
Resolution only matters to printing devices (and 
technically scanners but that's fodder for another 
column). That’s right, resolution doesn’t mean a hill 
of beans until that image is headed for a printer, 
because only a printer can do anything with the 
resolution measurement. Your monitor just doesn’t 
care: A 72 ppi image will look exactly the same as a 
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3000 ppi image. That's why the whole resolution issue 
is so confusing.

How much do you need?

Now that you understand how resolution works, how 
much resolution do you need to make a gorgeous 
print? It depends on the printer. While the current 
crop of consumer-level inkjet printers do a fine job at 
225-250 ppi, a professional service bureau may 
require 300+. If it’s your own printer, run a few tests. 
If someone else is printing it, ask them what 
resolution they need--and if they don't know, find 
another printer... fast :)

Resizing a photo for print

Let’s take a photo from a high-quality digital camera. 
I popped open the photo in Elements and took a peek 
at its Image Size dialog to see what the resolution 
currently is and how many pixels we have to work 
with. You can open this dialog by choosing File > 
Resize > Image Size. As you can see below, my photo 
is 2599 x 1949 pixels, but only 72 ppi. Does this 
mean my photo is low-quality and unsuitable for 
print? Not at all. It merely means that the resolution 
needs to be changed *before* I try to print it.

Important things to note in the screenshot above:

1. At the bottom of the document window, you can 
see that the file is big—it’s 14.4 MB (circled in red 
above).

2. Note the pixel dimensions shown in the upper 
portion of the Image Size dialog: 2599 x 1949 (also 
circled in red). Remember these numbers.

3. Note the honking big physical dimensions of this 
image. If I were to try printing at its current 
resolution, it’d be over 36 inches by 27 inches... 
INCHES! I don't know about you but I don't have a 
large format printer!

Now, watch carefully as I increase the resolution of 
the image without altering the number of pixels.

Step 1: In Photoshop Elements, choose Image > 
Resize > Image Size. (In Photoshop, choose Image > 
Image Size.) TIP: Keyboard shortcut for either 
software: Command + Option + I.

Step 2: At the bottom of the dialog, uncheck 
Resample Image. This all-powerful, magic option 
locks the number of pixels contained in the image, 
thereby locking quality. Enter 300 into the resolution 
box and watch how the document size changes:

The image now has a resolution of 300 ppi and the 
physical size has decreased to about 8.5 x 6 inches. 
See how the physical dimensions of the image 
changed but the pixel information didn’t? I have 
exactly the same number of pixels I started out with: 
2599 x 1949; they’re just packed more tightly 
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together. The file size didn’t change at all—it’s still 
14.4 MB, as evidenced in the document window and 
in the Image Size dialog (another clue that the pixel 
data didn’t change). I haven’t changed the quality 
(pixels), I’ve just changed the measurement (ppi) 
which only affects the printed image.

Again, this is confusing because the onscreen image 
won't change a bit (see earlier paragraph on monitors, 
eyeballs, and brains). The truth is only revealed by the 
Image Size dialog. The thing to remember is that as 
long as you uncheck the Resample Image box, you 
can tweak the resolution ‘til the cows come home and 
you won’t alter the image quality at all. Ever. If you 
leave the Resample Image box checked, though, 
you’re messing with photo quality which you don't 
want to do when printing. If you're resizing an image 
for email or posting on a Web site, then leave the 
Resample Image box check because in those cases 
you really do want to lower pixel dimensions, thus 
lowering file size.

Making Elements do it for you

That being said, if you want to print a photo at a 
common size like 8 x 10 or 5 x 7, you can have 
Elements change the resolution for you. Just choose 
File > Print and pick a size from the Print Size pop-up 
menu towards the top of the dialog.

Resizing and changing resolution at the same time

You can also resize the image and change the 
resolution at the same time by using the Crop tool.

Step 1: Press C to select the Crop tool in either 
Photoshop or Elements.

Step 2: In the Options bar at the top of your screen, 
enter the dimensions of the desired image and the 
resulting resolution. TIP: Be sure to include the unit 
of measurement in the width and height boxes, as 
shown below. Draw a box around the important bits 
of your image and when you get it just right, press 
Return to accept the crop. TIP: Press the Escape key 
to exit a crop.

WARNING: If the image appears to enlarge on your 
screen, then you've surpassed the number of available 
pixels. In other words, you're trying to print it larger 
than it can really go at the resolution you've entered. 
If that happens, press Command + Z to undo and then 
enter smaller dimensions or lower resolution. It's okay 
if the image appears to get smaller on your screen.

Step 3: Choose File > Print to print it now, or save the 
photo to print later. If it’s being sent to someone else 
to print, choose File > Save As and pick TIF from the 
file format pop-up menu. TIFs can be opened in most 
image editors and are a lossless graphic format (high 
quality). You can also print directly from a native 
Photoshop or Elements document.
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Resizing for an email

With the new Elements 6, resizing an image for email 
has never been easier. Just click the green Share tab at 
the top right of the interface and press the Email 
Attachments button (circled below in red). If the 
image is too big, Elements will alert you with a dialog 
and offer to resize it for you.

Next, it'll pop open your email client, create a new 
message, attach the photo, and allow you to specify 
just how big the photo should be via a handy pop-up 
menu at the bottom right.

That's all there is to it! So get out there and start 
printing and emailing those images. And if you 
haven't upgraded your copy of Elements yet, get with 
it. In this column series we're going to be covering all 
kinds of wonderful new features that you are sure to 
enjoy. At the very least, download the 30 day trial and 
give it a spin.

Until next month, happy shooting!

Reprinted from:  www.graphicreporter.com/tutorials
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VueScan 8.4.66 Review
                                                  4 1/2 out of 5 Mice

Posted: 23-Jun-2008                               

Vendor: Hamrick                                       $39.95
Type: SHAREWARE                               Download
Class: PRODUCTIVITY

Reviewer: Bob French

Overview
VueScan is software for flatbed and film scanners. 
Since most, if not all, scanners come with bundled 
software, this product seems intended as replacement 
software. It also serves as software for older scanners 
where the owner may not have any scanner software, 
as might be the case if the owner picked up a scanner 
off e-Bay and only got the hardware. The software 
has a simple interface where scanner novices can 
perform the basic functions without the intimidating 
detailed list of options, but it also has an advanced 
look where even the most detail-conscious scanner 
expert can find a setting to toggle.

Hamrick Software produces VueScan, a commercial 
product. There is a free trial version available on the 
Hamrick website. The Standard Edition is $39.95, 
while the Professional Edition costs $79.95 (the price 
has come down by $20 since our last review). The 
Professional Edition provides unlimited upgrades for 
as long as you own the software, while the Standard 
Edition provides free upgrades for one year. The 
Professional Edition also handles raw scan files and 
some other options usually associated with a 
professional photographer. Version 8.4.66 of the 
Professional Edition was used for this review.

Setup
I downloaded the software from www.hamrick.com. 
It came as a .dmg image file, surprisingly small at 
only about 6.9 Mb. The image opened and I was 
presented with a simple icon. There was no alias to 
the Applications folder in the install window, so it is 
left to the user's discretion to drag the program to 
their Applications folder (or any other folder of your 
choosing). For a newbie user just learning the Mac, 

this could be improved (or at least covered in the 
user's guide, which it isn't).

In Use
When I opened the software for the first time, it 
detected that I did not have my scanner connected to 
my MacBook Pro, and it presented me a nice little 
dialog box telling me to close VueScan, connect my 
scanner, and then restart the software.

No Scanner Installed Dialog

This little detection routine is a nice touch for 
someone like me who uses a laptop and has to plug in 
the cord each time I need to use the scanner. Desktop 
users, of course, may never encounter the situation.

VueScan assumes you are a novice and opens with 
simplified options preset for you. They guide you 
through the steps in this mode. The opening screen 
starts with the task selection. That is, it asks you what 
you want to do. Scan to a file is the default condition.

Guided Opening
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You can also scan directly to your printer, making 
your scanner into a copy machine. The other options 
offered are much more complex. They allow you to 
profile scanner, profile printer, profile film, or make 
IT8 target. I don't understand what these are, but the 
User's Guide does describe them.

Task Options

Clicking on the Next button brings up the next guided 
page where you are asked to choose the media you 
are scanning. You have context sensitive help 
displayed to guide your decision. Your options are 
Color Photo, B/W Photo, Line Art, Text, Magazine, 
and Newspaper.

Choosing Your Media

Pretty simple so far. Next, you have to choose your 
quality. Options are E-mail, Web, Print, Edit, and 
Archive. The first three made sense to me, but I had 
to go to the User's Guide to see what Edit and Archive 
were all about. Each item increases the quality and, 
consequently, the size of the resulting file. The 
'Archive' selection produces a resolution at your 
scanner's maximum resolution. The others are listed 
in the following graphic.

Image Quality Table

Once you have selected the quality of your output and 
clicked on the next button one more time, your 
scanner kicks in, and creates a preview image for you. 
At this point you have the opportunity to select the 
crop size. I use manual, so I can adjust the amount of 
the scanned image I want saved. VueScan also lets 
you choose from a long list of fixed sized for 
common items. Clicking 'next' again scans your item 
and presents you with a standard file dialog box 
where you name your image and save it to a location 
on your computer. There are many options available 
in the preferences, including one where you can have 
your scans automatically named in sequence, a handy 
option for sure.

While the guided screens are nice for newbies, once 
you become familiar with VueScan, you will likely 
want to use the "advanced" screens (by clicking on 
the "Advanced" button). You can always return to the 
Guide by clicking on the "Guide Me" button. The 
advantage of using the advanced mode is that you can 
set up your parameters just once, and each time you 
scan, you just click on Preview (rather than go 
through the Guide screens). There are also two levels 
of advanced screens. The standard screens provide 
just enough control settings for the average user. For 
power users, you can select "More" and get access to 
more detailed settings (such as "Bits per Pixel", 
"Border %", "Black Point", "White Point", and much 
more).
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VueScan has a nice little feature if you are scanning a 
stack of photos that are all the same size. You can 
select auto repeat and scan without having to click on 
the scan button each time. You put your first picture 
down on the scanner, click on scan with the auto 
repeat > 5 set and away you go. Once the first picture 
is scanned, replace it on the scanner with next. Five 
seconds after the first scan, the second one will start, 
and so on. I found this to be a nice touch. I haven't 
had this kind of convenience on any of my scanners 
since way back to my first OneTouch scanner (with 
the OneTouch, you pressed a button on the scanner 
and the software knew what to do). 

Multi-page documents are also no problem for 
VueScan. The User's Guide has a nice description of 
scanning a multi-page document into a pdf file, for 
example. I found this very handy for some of the 
financial documents I still get in the mail. After 
previewing the first page, set the crop to Manual and 
the Output to PDF with multi-page checked, and hit 
scan. Repeat this for each page. When you are done, 
Select Last Page from the file menu. It definitely 
helped using the User's Manual for this task.

Creating Multi-page PDF Documents

Summary
Hamrick Software's VueScan is for flatbed and film 
scanners, providing high quality images from 
negatives, slides, old photos, and anything else that 
you need to scan. It serves both as replacement 
software that may have more features than your 
scanner's software, and also as a solution for older 
scanners that have no OS X drivers (or scanners 
bought without software, such as on eBay). The 
software has a simple interface where scanner novices 
can perform the basic functions without the 
intimidating detailed list of options, but it also has an 
advanced look where even the most detail-conscious 
scanner expert can find a setting to toggle. Whether 
you are scanning color prints, black and white 
negatives, multi-page documents into PDF, or other 
options, VueScan is easy to use and provides a 
detailed User's Guide for those who want to dig into 
its more detailed options. VueScan is great for 
hobbyists looking for easy-to-use scanning software 
to get high quality images from old photographs, as 
well as for advanced users in need of color-matching 
and other advanced settings not often found in OEM 
scanner software. 

Pros
 • Works with many older scanners
 • Provides simple user interface, as well as 

varying degrees of more complex screens
 • Lots of useful features, including multi-page 

PDF creation
 • Warns you if it detects that no scanner is 

installed
 • Has an excellent User's Guide

Cons
 • Lacks instructions about installation
 • May not be worth the cost for those already 

happy with their scanner software

Overall Rating
4 1/2 out of 5 Mice

Reprinted from the site of The Macintosh Guild - 
home page:  http://macguild.org/
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Is MobileMe Worth the Money?
by Claire J Rottenberg             CJRTOOLS ebooks
If you're not a subscriber to Apple's online service, 
MobileMe, you might be wondering if the service is 
right for you. Maybe you are a subscriber and you're 
not sure if you should renew your subscription. In this 
article, I briefly describe the main MobileMe services 
so you can decide if the service is worth the cost.

Syncing Feature
Apple has emphasized the syncing capabilities of 
MobileMe as the central element of the service. The 
syncing feature of MobileMe is easy to use and can 
be set to sync your computers and iPhone or iPod 
Touch to the online MobileMe application. You can 
sync your email accounts and messages, Address 
Book contacts, Safari bookmarks, and iCal calendars. 
Some third party applications may also let you sync 
data from them. Syncing can be automatic so that 
every time you make a change on your computer, the 
change is automatically synced with the online 
MobileMe service or, if you prefer, you can manually 
sync your data by accessing an option from the Mac 
OS X menu bar. Although syncing does not work 
quite as quickly or smoothly as Apple first stated it 
would, it does work well for most setups.

Email Service
The MobileMe package includes an excellent IMAP 
email service. Although the new email account name 
(yourname@me.com) is not pleasing to all users, the 
service has advantages over other email services. I 
have several email accounts, including a Gmail 
account, and the MobileMe email service uses spam 
filtering that is far superior to that of other accounts. 
Unlike some other accounts that place all spam in a 
junk mailbox, MobileMe filters out the spam before it  
ever reaches your mailbox so very little junk mail 
actually gets to you.

In addition to excellent spam filtering, the MobileMe 
email service provides you with an enormous amount 
of storage space so you can keep all of your email 
messages in one account. Also, since the account is an 
IMAP account, you can keep your online and offline 
mailboxes always in sync.

Online Storage
Another benefit of MobileMe is the 20 GB of online 
storage space that comes with the service. Because 

your MobileMe iDisk can be mounted on the desktop, 
you can add photos, music files, videos, and other 
files to the iDisk just as you would to any hard drive. 
In addition, the new online interface has an upload 
option that lets you add files to your iDisk from any 
computer. Now, with MobileMe, you can have a safe, 
offsite location for storing your important data.

Web Hosting
A MobileMe account has one more useful feature - a 
web hosting service with huge bandwidth limits (200 
GB per month). Although Apple only advertises its 
hosting service in combination with Web Galleries 
and iWeb, you can, in fact, use any web design or 
development application with MobileMe. Publishing 
a website to your MobileMe account can be done 
from within some applications, such as RapidWeaver, 
or you can simply drag a website folder to either the 
Sites or Web folder on your iDisk to create an instant, 
live website. MobileMe's web hosting service doesn't 
provide all of the special features of most dedicated 
web hosting services, but it is more than adequate for 
many users' needs. And the 20 GB of storage space 
plus the 200 GB of monthly bandwidth make it 
perfect for photo album sites that you might want to 
share with your friends or with the world.

Conclusion
Is MobileMe worth the money? If all you want is a 
syncing program or an email service or a web hosting 
service, MobileMe is probably not worth the expense. 
But, if you want or need two or more of the services 
provided, MobileMe is a good value. For $99 a year, 
you get the ability to sync data on all of your 
computers and your iPhone or iPod Touch, a good 
email service with excellent spam filtering, an easy-
to-use hosting service, and enough offsite storage for 
your email, websites and important data.

* Note - Since MobileMe is a new service, it still has some bugs 
in it that Apple is working hard to resolve. For example, while 
working on this article, my email account on MobileMe became 
inaccessible for a short period of time. Hopefully, Apple will 
work out the bugs soon and MobileMe will be the smooth 
working service Apple has promised users.

Claire J Rottenberg is the author of Easy Guides to Mac OS X 
software (Safari, Mail, System Preferences, TextEdit) and 
Course Books on Mac OS X 10.5, iPhoto ’08, iTunes, and Mac 
OS X 10.4. More information on her books is available on the 
CJRTOOLS ebooks website (www.cjrtools.com/ebooks).
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Membership Application and Renewal Form

Name:     

Company (if mailed to):     

Address:     

     

City, State, Zip:     

Phone # (home):     

Phone # (work):     

Phone # (cell):     

Occupation (if applicable):     

Membership ID # (if renewal):     

Email:     

   Your e-mail address will NOT be sold, shared or distributed. It will be used to notify you of the availability of 
a new issue of the newsletter.

   Check if this is a change of address notice

   Check if you want to volunteer

   Check if you want to be added to “Members Helping Members”

   Check if you were referred by a club member (if so, please give member’s name)

Membership cost is $15.00 for one year. Please make your check payable to “mini’app’les”.

Please send this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!
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